RE N ESAS Application Note

Renesas RA Family

RA AWS Cloud Connectivity on CK-RA6M5v2 with Wi-Fi
DA16600- Getting Started Guide

Introduction

This document provides instructions for running AWS cloud connectivity Application Project on CK-RA6M5
v2 using Wi-Fi DA16600 interface.

Applies to:

¢ RA6M5 MCU Group

Required Resources

To build and run the MQTT/TLS application example, the following resources are needed.
Development tools and software

¢ Flexible Software Package (FSP) v5.1.0 and required tools (renesas.com/us/en/software-tool/flexible-
software-package-fsp)

Hardware

e Renesas CK-RABM5 v2 kit (renesas.com/ra/ck-rabm5)

e PC running Windows® 10 and an installed web browser (Google Chrome, Internet Explorer, Microsoft
Edge, Mozilla Firefox, or Safari)

e DA16600 PMOD: US159-DA16600EVZ - Ultra-Low-Power Wi-Fi + Bluetooth® Low Energy Combo
Pmod™ Board (Renesas Quick-Connect 10T) | Renesas

e Micro USB cables (included as part of the kit. See CK-RA6MS5 v2 —User’s Manual).

e USB-C cable for Power supply (See CK-RA6MS5 v2 —User’s Manual)

Prerequisites and Intended Audience

This application note assumes that the user is adept at operating the Renesas e? studio IDE with Flexible
Software Package (FSP). If not, we recommend reading and following the procedures in the FSP User's
Manual sections for ‘Starting Development’ including ‘Debug the Blinky Project’. Doing so enables
familiarization with e? studio and FSP and validates proper debug connection to the target board. In addition,
this application note assumes prior knowledge of MQTT/TLS and its communication protocols and
knowledge of Wi-Fi modems.

The intended audience is users who want to develop applications with MQTT/TLS modules using Wi-Fi
DA16600 modules on Renesas RA6 MCU Series.

Note: If you are a first-time user of e? studio and FSP, we highly recommend you install e? studio and FSP
on your system to run the Blinky Project and to get familiar with the e? studio and FSP development
environment before proceeding to the next sections.

Note: This Application Project and Application Note are guaranteed to work only with FSP v5.1.0
Prerequisites

1. Access to online documentation is available in the Cloud Connectivity References section.

2. Access to latest documentation for identified Renesas Flexible Software Package.

3. Prior knowledge of operating e? studio and built-in (or standalone) RA Configurator.

4. Access to associated hardware documentation such as User Manuals, Schematics, and other relevant
kit information (renesas.com/ra/ck-rabmb5).
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1. Importing, Building, and Loading the Project

1.1 Importing

This project “aws _ck raém5 wifi dal6600 app” can be imported into the e? studio using the
instructions provided in the RA FSP User’s Manual. See section Starting Development > e2 studio ISDE
User Guide > Importing an Existing Project into e? studio ISDE.

1.2 Building the Latest Executable Binary

Upon successfully importing and/or modifying the project into e? studio IDE, follow the instructions provided
in the RA FSP User's Manual to build an executable binary/hex/mot/elf file. See Section Starting
Development > e2 studio ISDE User Guide > Tutorial: Your First RA MCU Project > Build the Blinky Project.

1.3 Loading the Executable Binary into the Target MCU
The executable file may be programmed into the target MCU through any one of three means.

1.3.1 Using a Debugging Interface with e? studio

Instructions to program the executable binary are found in the latest RA FSP User Manual. See Section
Starting Development > e2 studio ISDE User Guide > Tutorial: Your First RA MCU Project > Debug the
Blinky Project.

This is the preferred method for programming as it allows additional debugging functionality to be available
through the on-chip debugger.

Follow the instructions for programming the board and proceed to section 1.4.

1.3.2 Using J-Link Tools

SEGGER J-Link Tools such as J-Flash, J-Flash Lite, and J-Link Commander can be used to program the
executable binary into the target MCU. Refer to User Manuals UM08001 and UM08003 on www.segger.com.
Use the . srec or .hex file in Application Project to program the board and proceed to section 1.4.

1.3.3 Using Renesas Flash Programmer

Renesas Flash Programmer provides usable and functional support for programming the on-chip flash
memory of Renesas microcontrollers in each phase of development and mass production. Use the .srec
or . hex file in the Application Project folder to program the board and proceed to section 1.4.

1.4 Connection Settings and Deviation

Reset the board assembly associated with this application note to the default electrical jumper settings as
specified in the CK-RA6M5 v2 User’s Manual before proceeding with the next set of instructions.

Note: For this Wi-Fi based cloud connectivity application project and application note, the user is required to
connect the DA16600 PMOD module to the connector (J26 — PMOD1) on the board.

1.5 Powering up the Board

To connect power to the board, connect the USB cable to the CK-RA6M5 v2 board’s J28 connector (USBC)
and the other end to the PC USB port. Connect the second USB Cable to J10 (USB_DBG) connector of the
CK-RA6MS5 v2 board and other end to the second USB Port of the PC (This will be the Console Port for
Application). Users are required to use the Command Line Interface (CLI) to configure and run the
Application.

Then run the debug application, with the instructions in the next sections.
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2. Running the Application Project

Note: The steps indicated below are tested on Window OS only.

2.1 Connecting the Board to the Serial port Console of the PC

1. On the host PC, open Windows Device Manager. Expand Ports (COM & LPT), locate JLink CDC UART

Port (COMxx) and note down the COM port number for reference in the next step.

Note: JLink CDC UART drivers are required to communicate between the CK-RA6M5 v2 board and the

terminal application on the host PC.

M Device Manager

File Action View Help
= m B

v &% VNM-5CG3060XX6

iy Audio inputs and outputs
E Batteries

@ Biometric devices

G Bluetooth

® Cameras
| Computer

w= Disk drives
& Display adapters

i Firmware
¥ Human Interface Devices

¥ Jungo Connectivity
— Keyboards

@ Mice and other pointing devices
3 Monitors

I Network adapters

L7 Other devices

@ Ports (COM & LPT)

# Intel(R) Active Management Technalogy - SOL (COM3)
@ JLink CDC UART Port (COM9)

M Print queues

L1 Processors

7 security devices

[ Sensors

!t Software components

B cnfhwara davicas

€

Figure 1. JLink CDC UART in Windows Device Manager

2. Open Tera Term select New connection and select Serial and COMxx: JLink CDC UART Port

(COMxx) and click OK.

i

File Edit Setup Contrel Window Help

OTCPIP myhost.example.com|
History
Telnet 2
SSH SSH2
Other
UNSPEC
® Serial Port: COM9: JLink CDC UART Port (COM9)  ~
oK Cancel Help

Figure 2. Selecting the UART Port on Tera Term
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3. Make sure Tera Term selects the black background, if not configure it from Setup > Window and make

the following selections.

Title: :Tera Term L
Cursor shape [ Hide title bar Cancel
® Block [[] Hide menu bar
() Vertical line [116 Colors [PC style) i
() Horizontal line [ 16 Colors [aixterm style]

[+] 256 Colors [xterm style)

Enable bold font (] Scroll butter: 10000 | lines
Color
® Text Attribute Normal
() Background Heverse
R: 255 <« >
G: 255 < >
B: 255 <« >

Always use Normal text's BG

Figure 3. Configuring the Black Background for JLink CDC UART Port on Tera Term

4. Configure for the terminal from Setup > Terminal..., select New-line Receive as AUTO.

1
Tera Term: Terminal setup X

Terminal size New-line -“
80 X |24

Receive: AUTO -

M Term size = win size Transmit: | cR v Cancel
Auto window resize
Help

Terminal ID:  VT100 v [ Local echo
Answerback: [J Auto switch (VT<->TEK)
Coding (receive) Coding (transmit)

UTF-8 v UTF-8 v

locale: american ‘ CodePage: |65001

Figure 4. Configuring Terminal

5. Using the Setup > Serial port... and ensure that the speed is set to 115200, as shown below.

i

File Edit Setup Control Window Help

Tera Term: Serial port setup *

o R
Speed; 115200 ~

Data: 8 bit ~ Cancel
Parity: none ~

Stop bits: 1 hit v Help
Flow control: none ~

Transmit delay

El msecichar D mseclline

Figure 5. Select 115200 on the Speed Pulldown Menu
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6. Complete the connection. The Configuration CLI Menu will be displayed on the console as shown below.
Note: Please reset the board by pressing the 81 user switch if the menu is not displayed.

. COM9 - Tera Term VT - (] Pt
File Edit Setup Control Window Help

> Select from the options in the menu bhelow:

. Get FSP version

. Data flash

. Get UUID

. Configure Wi-Fi

. Start Application
. Help

> Enter (1-62> to select options

Figure 6. Main Menu

7. Inthe CLI shown in the preceding screenshot, choose the number to select the commands. For
example, when you press 1, the FSP version of the application is displayed as shown below. At any
point of time, press the space bar to return to the previous menu.

File Edit Setup Control Window Help

1. GET FSP UERSION
5.1.8

> Prezsz space bar to return to MENU

Figure 7. FSP Version Information

2.2 Getting the UUID Information of the Board

1. Press 3 from the Main Menu to display the board UUID. This command obtains the UUID information of
the board and displays it on the console as shown in the screenshot below. You will need this
information for registering to the Renesas AWS Cloud Dashboard.

T COMS - Tera Term VT - O et
File Edit Setup Control Window Help

3. GET UUID
RA MCU 128-bit Unigue ID Chex>» =

» Prezss space bar to return to MENU

Figure 8. Getting Board UUID Information
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2.3 Registering to Renesas AWS Cloud Dashboard

AWS dashboard for Renesas CK-RAB6M5 v2 cloud kit is custom designed to visualize the data of all the
sensors on the cloud kits. The dashboard connects to AWS loT services through AWS IoT core and enables
users to utilize the cloud services to full potential.

To allow users to experience a hassle free first experience of the cloud kits, every cloud kit is credited with
$10 USD AWS credits upon registration.

The dashboard can be accessed at https://renesas.cloud-ra-rx.com/

2.3.1 Sign up.
After establishing the access of the RA and RX kit to kit-associated AWS sub account, where all necessary
infrastructure will be provisioned, each user should sign up:

1. Go to the https://renesas.cloud-ra-rx.com/
2. If you don't have an account, click on the Sign up button. You are directed to the Sign up page.

RENESAS

dprd N
w ;,“ (T3

Sign in to Dashboard

Figure 9. Creating Account

3. Enter your first name, last name, email address and password and press on the button Register.

(@ = 4% = .
Sign up

Figure 10. Registering Information

The rules for a valid first name and last name:
e Length Constraints: Minimum length of 2. Maximum length of 24.
e Information must be entered in English or another Latin character-based language.
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The rules for a valid email address:

The address must be a minimum of 6 and a maximum of 64 characters long.

All characters must be 7-bit ASCII characters.

There must be one and only one @ symbol, which separates the local name from the domain name.
The local name cannot contain any of the following characters: whitespace, "' () <>[1:;,\| % &
The local name cannot begin with a dot (.)

The local name cannot contain double Plus, for example: account+rnss+alpha@domain.com

The domain name can consist of only the characters [a-z],[A-Z],[0-9], hyphen (-), or dot (.)

The domain name cannot begin or end with a hyphen (-) or dot (.)

The domain name must contain at least one dot.

The rules for a valid password:

e The password must be a minimum of 8 and maximum of 64 characters long.

o Password must contain at least one uppercase character, one lowercase character, one number, one
special character: ' #$ % & * ? @.

4. Verification code will be sent to your email. Enter the code and press on the Send button. You are
redirected to the Register Device page.

RLENESAS

e s

Confirm your amail

Figure 11. Confirming Email

If you do not receive an email with the code, please click on Resend Code.

5. Enter the UUID of the kit to complete the registration process. UUID is the unique ID of your board. Refer
to “CK-RAB6M5 AWS Application Project” for steps for obtaining the UUID of the kit (Go to section 2.2).
Note: Only 1 device will be assigned to an account.

RENESAS

o = ’%\‘ S o

Register Device

Figure 12. Registering Device

R11ANO812EU0110 Rev.1.10 Page 8 of 31
Dec.22.23 RENESAS



mailto:account+rnss+alpha@domain.com

Renesas RA Family = RA AWS Cloud Connectivity on CK-RA6M5v2 with Wi-Fi DA16600

6. The registration page indicates that the device registration is in progress.

LENESAS

8 = 4% = o

Account name: &, Downioas Cartificats

Ga T Dushboard b

Figure 13. Device Registration in Progress

7. Refresh the page and the status of the registration changes to ‘Provisioned’.

RENESAS

E— = ',':\\ g~ o

Device 1 Status: Provisioned ~

Figure 14. Sub Account Registration

8. The dropdown button next to the status displays the device information and option for downloading the

certificates.
RENESAS
b o e 4% = e
Mo
LLaDr
Figure 15. Completing Device Provisioning
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2.3.2 Signin
If you have already registered on our web portal, you need to Sign in entering your email and password.

2.3.3 Forgot password
1. Click Forgot password on Sign into Dashboard page. You are directed to the Restore Password

page.

RLENESAS

== Y e
A 5 [ ~
-

Restore Password

Figure 16. Restoring Password 1

2. Enter your email and click on the button Send.

RENESAS

2 — i e

Restore Password

Figure 17. Restoring Password 2

3. You should receive a verification code to your email.
4. Enter the code, your new password and confirm it.
5. To end the process, press on the button Send.
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2.3.4 Profile page

To see your profile page:
1. Click on your user’s picture - top right. Select Profile.

LENESAS

= e

| |
[T

Wil A

Figure 18. Selecting Profile

You are redirected to the Profile page:

LENESAS

. = %" = o
Profile Page
=3
Figure 19. Profile Page
On the page you can edit your profile:
A. Press on the button Edit Profile.
B. Change your First name and Last name.
C. Press on the button Send.
D. Your Account Name is updated.
LENESAS
g
5 = 9 = o
Profile Page

—

Figure 20. Updated Profile Page
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Also, you can change your password, the rules for a valid password have been mentioned above:
Press on the button Change Password.

Enter your Old Password.

Enter your New Password.

Confirm your New Password and press the button Send.

Your password is updated.

moow>

RENESAS

. = N = o

Profile Page

Firat name:
APTGN

LaSN P
Tour

—

Figure 21. Changing Password on Profile Page

2.3.5 Support Page

To see your support page:
Click on your user’s picture - top right. Select Support page.

LENESAS

g = o

Prod Upatentace

Daviee 1 Btabus: Provis

Account name: l r
ppcrt Fage
Emaiil

uwaD

Figure 22. Selecting Support Page

RENESAS

. = fant e 0

Support Page

XA K I ormaticn
CHRKBSH Kt btormation
Parrkn WA R ¢loud wolutiond
RA Product infesmation

FEX Product infermation

RA Product Seppon Farum

R Product Suppert Forum

Fenesas Suooart

Figure 23. Support Page
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2.3.6 Downloading the Certificate
Click on the Download Certificate button to download the credentials, certs.zip file and unzip this file.

g
b o = 4 = e
#,
st e ===y
e ——— e BijLmﬂ ]
Eminil

[1F]1: 3

Figure 24. Downloading the Certificate
2.4 Storing the Device Certificate, Key, MQTT Broker Endpoint, and loT Thing
Name

Device Certificate, Device Private Key, MQTT Broker Endpoint, and IOT Thing name need to be stored in the
data flash for the application to work.

1. Press 2 on the Main Menu to display Data Flash related commands as shown in the following
screenshots. This sub menu has commands to store, read, and validate the data.

T COMS - Tera Term VT — O >
File Edit Setup Contrel Window Help

» Select from the options in the menu below:
2. DATA FLASH

Info

Urite Certificate

Write Private HKew

Write MQTT Broker end point

Write IOT Thing name

Read Flash

Check credentials stored in flazh memory
Help

> Enter (a — h> to select options Cor press space bar to return to main MENU)>

Figure 25. Data Flash related Menu and Commands
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2. To store the Device Certificate, press the option b and Click the File tab of the Tera Term and Send
File option and choose the device certificate file ‘xxxxxcertificate.pem.crt’ from the downloaded
certs.zip file in section 2.3.6.

¥ COMS - Tesa Term VT o O X

File § Edit Setup Control Window Help

Mew connection... Alt=MN N

the menu below:
Duplicate session Al+D
Cygwin connection Alt=G
Log...

int

iII F ln.‘lh'h meERory

I Send file... tionz Cor press zpace bar to return to main MEMUD

Transfer »

Change directory..,
Replay Log..

TTY Record
TTW Replay

Primt... Alt+P

Disconnect Alt=|
Exit Alt«C
Exit All

Figure 26. Accessing the Device Certificate

File Edit Setup Contrel Window Help

DATA FLASH WRITE CERTIFICATE

Select the file to write data in data flash

T Tera Term: Send file

e Er

Date modified

Look in: certs "

Name

6/15/2022 4:30 AM

_pl certificate.pem.crt I 6/15/2022 4:30 AM
1ot-data,json 6/15/2022 4:30 AM
private.pem.key 6/15/2022 4:30 AM

<

File name:

certfficate pem crt

Files of type: A" ")
Option
[]Binary
Figure 27. Downloading the Device Certificate into the Data Flash
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I COM9 - Tera Term VT
File Edit Setup Control Window Help
DATA FLASH WRITE CERTIFICATE

Select the file to write data in data flash

Writing flash data is successful

> Press space bar to return to MENU

Figure 28. Status of the Downloaded Device Certificate into the Data Flash

3. To store the Device Key, press option ¢ and click the File tab of the Tera Term. Select the Send File
option and choose the Device Key “xxxxxxxprivate.pem.key” from the downloaded certs.zip file in
section 2.3.6

4. To store the MQTT Broker end point, copy the end point string xxxxxxxxxx3ku-ats.iot.us-east-
1.amazonaws .com from the iot-data.json file in certs.zip file. Press option d and click the Edit tab of
the Tera Term and Paste<CR>. Verify and confirm the valid string and press OK.

Note: Make sure to NOT copy the double quotes when copying the MQTT Broker end point.

File Edit Setup Contro Window Help

B | Tera Term: Clipboard confirmation X
ﬁ.Iot.us-east-l.amazona'.\-s.ctJm | oK |
Cance
Figure 29. Storing the MQTT Endpoint into the Data Flash
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5. To store the IOT Thing Name, copy the Thing Name string xxxxxxxx-5736XxXX~XXXXXXXX~
4edbxxxx from the iot-data.json file in certs.zip file in section_2.3.6. Press option e and click the Edit”
tab of the Tera Term and Paste<CR>. Verify and confirm the valid string and press OK.

Note: Make sure to NOT copy the double quotes when copying the Thing Name.

DATA FLASH WRITE THING NAME

Type or Paste credential and press enter to save credentials in flash

B | Tera Term: Clipboard confirmation

20N 5 7 SRR = 3 - | | OK

Cancel

Figure 30. Storing the MQTT Endpoint into the Data Flash

6. Press option f and g to read and validate the stored information in the data flash. Press the space bar to
go to the previous menu.

Note: Validation of the stored data is very limited and validates minimum set of data points. Users are
required to input the valid data to the flash obtained from the Dashboard for the proper working of
the application.

2.5 Storing the SSID Name, Password and Security Option

SSID Name, Password and Security option need to be stored in the data flash for the Wi-Fi connection of
application.

1. Press ‘4’ on the Main Menu to display CONFIGURE Wi-Fi related commands as shown in the below
snapshot. This sub menu has commands to store and read the data.

T COM3 - Tera Term VT — O x
File Edit Setup Contrel Window Help

» Select from the options in the menu below:
4. CONMFIGURE WIFI

a) S5ID Mame

b» Password

c? Security Option
d> Help

> Enter (a — d) to select options Cor press space bhar to return to main MENU)

Figure 31. Configure Wi-Fi related Menu and Commands
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2. To store the SSID Name, press the option ‘a) SSID Name’ and input the SSID. The maximum length of
SSID is 32 characters and the minimum length is 2 characters.

Note: For verify the input, click the “Setup -> Terminal -> Local echo” of the Tera Term as below.

Terminal size New-line P
80 ‘ X |24 Receive: AUTO -
I Term size = win size Transmit: ¢R v Cancel
Auto window resize
Help
Terminal ID:  VT100 v Local echo
Answerback: O Auto switch (VT<->TEK)
Coding (receive) Coding (transmit) v
UTF-8 v UTF-8 v

locale: |american CodePage: |65001

Figure 32. Terminal setup for the Local echo mode

YT
File Edit Setup Control Window Help

DATA FLASH WRITE SSID HAME

Type or Paste credential and press enter to save credentials in flash
P-Link_2582

Jriting flash data is successful

» Press space bhar to return to MENU

Figure 33. Storing the SSID Name into the Data Flash

3. To store the password, press the option “b) Password”, input the password, and confirm the valid string
then press OK. The maximum length of password is 32 characters, and the minimum length is 1
character.

T COM9 - Tera Term VT — O >
File Edit Setup Control Window Help
DATA FLASH WRITE PASSWORD
Type Wi-Fi’s Password and press enter to save credentials in flash
User Input: s

Writing flash data is suc zsful

Press space har to return to MENU

>
l

Figure 34. Storing the Wi-Fi Password into the Data Flash
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4. To store the security type, press the option “a) None” for Open Wi-Fi, “b) WPA” for WPA security, ’c)
WPAZ2” for WPA2 security to match the correct security settings for Wi-Fi's configuration.

I COM9 - Tera Term VT - | x
File Edit Setup Control Window Help

> Select from the options in the menu helow:

4. WIFI SECURITY

a? None

b> WPA

c> WPAZ2

> Enter (a — c¢) to select options <or press space bar to return to Wi-Fi MENU>

Writing flash data is successful

Security option "WPAZ® saved in the data flash successfully

> Press space bar to return to MENU

Figure 35. Storing the WPA2 security into the Data Flash

Note: Users can verify the information of Wi-Fi credentials stored in flash by going back to the “Main Menu”
and choosing option “2. Data flash” > “f) Read Flash” or “g) Check credentials stored in flash memory”
as described in step 6 in section 2.4.

| COMO - Tera Term VT — | e

File Edit Setup Control Window Help

0ZBu3Ln4?78c JqLESx6 /s +ulM19 y8m+KFM+pKc JUAoGAUQkUY4S»BxnEl quck 1hI
3G4J9f GSCum+ 1Ny +Mr? yk=TPubWJBQY6 vt 26 F1IBTnUJZbuJk+uLuFk1rB8QP ;781
AAtHE JSSwuxd] tDwJ50Bo jcMdCue Q8 1 gGhf EdSouvbNNnnd +aSUIZZMc te BopjgmKH
buv2AUDJgSLtnyAbnilY 7vBBCgYBge +3hilll oHeunHgt 31 9HYM+CUd 1t hzhDMI akN
pzox0¥ JZ/11ibJYQq?hQp?NnAQZ4 -BMFugqBB1 Gn i 1LO»GQUD4uuD824vaBZles 1UU
US5Ib+6M?UaBdaPNRk?8 D1 kg41L0oudkjc ?ZUut6 Lr/kT Jnyc LZpHuHNCLmPC1 Zk
hLpPl1QKBgBjid4mACSx44Ls +Adg4QiDT o8 jFCBcaFjaKo BrBGUP?pJuwCAIRh47R
QTh1kCFSFhN+ItomsxI g?gqNC4vli3hP1nalBxKrABmgFlo4uW8po8 jS-AKhl4ceNO
¥YSzFh9s8UeB . xBI bMpOg5 1Ky +h5T /UnChJhUBEU20vYU1T +ULI0oJ

————END RSA PRIVATE KEY

AWS MQTT end point read successful
g e o Yt -—= zt—1.amazonaws.com

lE read successful

> Press space bar to return to MENU

Figure 36. Checking Wi-Fi Credentials by Reading Flash
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2.6 IloT Cloud Configuration and Connecting to AWS loT

Sign in to Renesas AWS dashboard at https://renesas.cloud-ra-rx.com/login using an email account that has
been used to sign up for AWS account previously.

Note: It is important to sign up with an email that is not used previously to open an AWS account since the
dashboard creates a new AWS account linked to the email address.

Note: Store the invitation email for future, it may be required to access the AWS account.

2.7 Starting the Application

After registering to the Dashboard, configuring the required Cloud credentials and configuring the required
Wi-Fi credentials through the CLI, the application is ready to run. Press option “5. Start Application” to start
the application. The application prints a Welcome screen along with the status of validating the Cloud
credentials data present in the data flash as shown below.

Note: If choosing “Open security” for Wi-Fi credentials, the application will not require the Wi-Fi password.

File Edit Setup Control Window Help

HECK CREDENTIALS STORED IN DATA FLASH

Certificate saved in data flash is verified and successful

Private key saved in data flash iz verified and successful

MQTIT end point saved in data flash iz verified and successful

I0T thing name saved in data flash is verified and successful
S8ID saved in data flash is wverified and successful

Password saved in data flash is werified and successful
Security saved in data flash is verified and successful
Etarting AWS cloud Application....

Renesas FSP Application Project for AWS Core MQTT
Application Project Uersion 1.8
Flex Software Pack Uersion 5.8.8

Refer to Application Wote for more details on Application Project and
SP User’s Manual for more information about AWS Core MQTT

t?* Wi-Fi Init Successful ?1%ae

Figure 37. Welcome Screen on the Console

1 COM9 - Tera Term VT - O X
File Edit Setup Control Window Help

FSP User’s Manual for more information about AWS Core MQTT
*%? WYi-Fi Init Successful ??%xe

S8ID: TP-Link_2582
Password: 12345689
Connecting to TP-Link_ 2582

Wi—-Fi connected to SSID .

Device 1P address: 192.168.284.31
Device network mask: 255.255.255.8
Device gateway address: 192.168.204.808

MQTT End point a3SgeBsd2Vozzd-ats.iot.us—east-1.amazonaws.com with IP address
52.73.131.86

Successful MQTIT Connection to the end point a35geBsd2ozzd-ats.iot.us—-east-1.am
Z0onaws .com

Device is Ready for Publishing and Subscription of Messages

Sequence Number =
received from IAQ sensop
data tvoc 0.208140

data etoh 0.118713

data eco2 431.300812

Figure 38. Connecting to the Network and AWS loT
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2.8 Verifying the Application Project from the Renesas Dashboard
Renesas AWS dashboard can be accessed from renesas.cloud-ra-rx.com by clicking on Go to Dashboard.

Note: Users will have access to Grafana dashboard only when the device is provisioned, and the device
status is “Active”.

= 4" e o

Figure 39. Accessing Renesas AWS Cloud Dashboard

First time users will access the dashboard with credentials “admin” for both username and password and
will be directed to change the password.

Welcome to Grafana

Figure 40. Welcome to Grafana Screen

Click Skip to access the dashboard.

Welcome to Grafana

Figure 41. Skipping Grafana Screen to Access Dashboard
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On the Renesas dashboard page, the sensors data can be viewed by clicking on the “arrow” next to each of
the sensor data tabs. Allow up to 60 seconds for the data to be displayed on the dashboard. If the data is not

updated as expected, refresh the page.

Figure 42. Renesas AWS Cloud Dashboard

3. Dashboard Types
Depending on the sensors, you can choose one of the dashboard types: Renesas 6-Axis sensor or Renesas.
Click on Renesas option.

Figure 43. Renesas AWS Cloud Dashboard Types

Choose Renesas 9-Axis sensor.
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Figure 44. Choosing Renesas 9-Axis Sensor

Figure 45. Renesas Dashboard displays 9-Axis Sensor

In CK-RABMS5 v2, only supports 6 Axis sensors (Gyroscope, Accelerometer), Magnetometer will always be
zero.
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4. Sensor Data for Cloud Kits

The Grafana dashboard displays the following Data from sensors.

Table 1. Sensor Data from Grafana Dashboard

Sensor Data

HS3001- Humidity and Temperature Sensor Temperature, F
Humidity, %

ZMOD4410- Indoor Air Quality Sensor Etoh, ppm

ECO2- Estimated Carbon dioxide, ppm

TVOC - Total Organic Compounds, mg/m*3

OB1203 - Heart Rate, Blood Oxygen Concentration, [SPO2, %

Pulse Oximetry, Proximity, Light and Color Sensor |4 (Heart Rate), bpm (beats per minute)

RR (Respiration Rate), breaths per minute

P2P

ICP20100 - Barometric Pressure and Temperature [Temperature, F

Sensor Barometric Pressure, mbar

ICM-42605 Motion Tracking Sensor )Acc values, unit: g

Gyro Data, unit: dps (degrees per sec)

Mag Data, unit: mT

OAQ — Outdoor Air Quality OAQ, ppm

5. Alerting and Anomaly Detection

Grafana alerts are a way to send notifications when a metric crosses a threshold that has been configured.
By default, the dashboard has thresholds for the following sensors:
e 0OB1203-SP0O2: SPO2 above 90, SPO2 below 90
e HS3001 - Temperature, F:
e Temperature — Cold: below 65
e Temperature — Warm: within range from 65 to 85
e Temperature — Hot: above 85

Figure 46. Sensor Status Feedback

Sensor status feedback is sent to the device which is indicated by the LEDs.
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6. AWS Account Sign up and Payment Preference Updates.

Access the AWS account by clicking here.
1. Use the same email address that was provided at the registration in section 2.3.1 step 3.

dws

Sign in to cloud-ra-rx

Username

Next

By continuing, you agree to the AWS Customer Agreement or
other agreement for AWS services, and the Privacy Notice. This site

uses essential cookies. See our Cookie Notice for more information.

Figure 47. AWS Sign up Page

2. To access your AWS account, you will need to reset your password. Click the Forgot password button

to initiate the password reset process. Expect to receive password reset instructions via email.

dWS

Sign in to cloud-ra-rx

Username:
cran amiranidckad@ronseac eam [nat van?l
Passwaord
I
Show password Forgot password | — Reset paSSWOFd
Sign in
Cancel

Figure 48. Reset Password
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3. After login you are redirected to Single Sign-On page. The AWS sub account can be accessed from the
Management console link.

5:-'1'-':]"'.:' .L_:-i':;'lrl—[:”"l MFA devices | Sign out

W Test

AWSAdministratorAccess Man |§.""-:'I cansole Comm and line or :Jlr:gl.‘.llun.:l,u' ACCESS

Terms of Use Powerad by aws

Figure 49. Single Sign-On Page
6.1 Update payment options
Note: To avoid account from being quarantined post the usage of $10 AWS credits, payment options must
be updated.

1. Payment options can be accessed from the ‘Billing and Cost Management’ section of the console.

- Console Home i
i Recently visited iofo : i Applications (0) o
Syst Cont Organization
Clou h E us-east-1 (Current Region) v Q Find applications Service Quetas
B sterr B - gilling and Cost Management
B o B o Name a | Description m
Swich role
m AP Gate ﬁ 53
" @ » Access denied
B =
Go to ‘Billing’ to add payment options
“ Go to myApplications P
i Welcome to AWS g it AWS Health o 3 it Cost and usage ifo
@ » Access denied
G2
hvd
No health data
't hay
Figure 50. Billing and Cost Management
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2. Scroll to the ‘Payment Preferences’.

2] L @ [} Global ¥ AWSAdministratorAccess/snee.amirapu

Cost Anomaly Detection @ We combined the Billing console and the Cost Management console B ©
Free Tie ‘The combined console has a new home page to help you make faster, better-informed cloud financial management decisians, and a more intuitive side navigation that provides quick access to familiar pages
like Bills, Payments, and Cost Explorer. You can access legacy pages via the "legacy pages” section of the navigation bar. To learn mare, refer to the user guide.

Data Exports New

Cost Organization

Billing and Cost Management home . Reset layout

Cost Categories

Billing Conductor 3 i Cost summary info i Cost monitor it

Budgets and Planning

oot Month-to-date cost Last month's cost for same time period
Budgets

$0.00 $0.00
Budgets Reports 4 0% compared to last menth for same period Now 1 -

Pricing Calculator (2

Savings and
Commitments

Cost Optimization Hub New
» Savings Plans View bill p P
b Reservations

it Cost breakdown info # Recommended actions (0) e

Preferences and Settings

Grouj by
+———=Z22 Go to ‘Payment Preferences’

Service ¥
o)
Casts ($) @ L
000
Legacy Pages No recommended actions
Billing Home Try again later
Jul 2023 Aug 2023 Sep 2023 Oct 2023 Nov 2023 Dec 2023
B Others

Figure 51. Payment Preferences

T m—

Billing and Cost x Billing and Cost Management > Payment Preferences
Management o)

Payment preferences i Contact us [

Getting Started New Default payment preferences info

Home New

Billing and Payments

Bill
- @ Default payment method does not exist. Add a default payment method and reload.
Payments
Credits
Purchase Orders
Payment methods Payment profiles
Cost Analysis
Payment methods (0) it Add payment method
Cost Anomaly Detection Q Find payment method
Free Tie
Data Exports New

No payment methods

Add Payment Method

Cost Organization

Cost Categories

Billing Conductor [
Budgets and Planning
Budgets

Budgets Reports

Pricing Calculator (4

Savings and
Commitments

Cost Optimization Hub New

Figure 52. Add Payment Method

7. Renesas AWS Dashboard account credits and quarantine

Every kit registered to the dashboard will include a $10 AWS credit. When the credit is exhausted the
account is quarantined.

To avoid the account from being quarantined,

1. Update the payment method in the AWS account as shown in section 6.1.
2. In addition, the dashboard must be updated with the payment preference from the user profile on the
dashboard page.
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A. Go to the user profile.

RENESAS

Sree Amirapu

Device 1 Status: Provisioned
Go to the user profile on dashboard —

Re o

Figure 53. User Profile on Dashboard

B. Confirm the payment preference updates.

RENESAS

) =~ g =~
L] RA 1, 533
7]
Profile Page
First name:
stoe
Last name:
Amitapu

[E—— (s =< O o

Figure 54. Payment Preference Update

Note: Failure to complete either of the steps 1 or 2 will result in the account being quarantined. For access
to quarantined accounts, please contact Renesas Support team.

7.1 Disable EC2 Instance to save credits.
To avoid account credit usage when the device is not in use, disable the EC2 instance.

1. Access EC2 from the AWS account by logging into the account as mentioned in section 6,and use the
following steps.

B & @ @ Gobslv  AwSAdminiswatorAccess/sree.amirspuschv2genesas.com v

Recently visited

Favorites A Contact us [

All services
Console Home

Analytics

Application Integration

Blockehain
1 Business Applications CloudWatch

Cloud Financial
Management
O compute Add payment method
£ Containers
%) Customer Enablement
Database
No payment methods
% Developer Tools
hent methods on file. Ad
End User Computing
Front-end Web & Mobile
% Game Development
% Intemet of Things
@ Machine Leaming

Management &
Governance

2 Media Services

Migration & Transfer ; Go to ‘Services’ > ‘EC2’

Feedback © 2025, Amazon Web Services, Inc_ or ts afilistes.  Privacy  Terms  Cookle preferences

Figure 55. Go to EC2 Services
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2. Go to the instances.

2] L @ [c] N. Virginia ¥ AWSAdministratorAccess/sree.amirapus ckv 2@renesas.com

Instance state ¥ Actions ¥ Launchinstances ¥

1 @

[e]

Instance ID Instancestate ¥ | Instancetype ¥ | Statuscheck Alarm status Availability Zone ¥ | Public IPvd DNS % | PubliclPvd.. ¥ | ElasticIP |

i-091a13b136e54136¢ @-rurning & &  t2micro © 2/2checkspassed Noalarms +  us-east-1a £€2-3-80-10-41.comput 3.80.10.41

Instance Types
Launch Templates

Spat Requests

Savings Plans

Select an instance
¥ Images

atalog

¥ Elastic Block Store
Volumes
Snapshots
Lifeeycle Manager
¥ Network & Security

Security Groups

Elastic IPs.

Figure 56. Go to EC2 Instances

3. Select the instance to be disabled and change the ‘Instance State’ to ‘Stop instance’.

B & @ @& NVgeav AWSAdministratorAccess/sree.amirapu+ckv2@renesas.com ¥

x Instances (1/1) isfo (¢ Connect | Instance state & || Actions ¥ Launch instances ¥

Q. Find Instance by attribute or tag (case-sensitive Stop instance 1 ol

Events Name £ @ | Instance ID Instance state ¥ | Instancetype ¥ | Status check Alarm status Availability Zone ¥ | Pul Public IPvd ... ¥ | ElasticIP
Reboot instance

Console-to-Code
. | I Grafana i-091213b126e54136¢ @-running & & 12micro @ 2/2checks passed  Noalarms +  us-east-la eci 3.80.10.41
Terminate instance

¥ Instances
Instances 1. Choose the Instance

Instance Types

2. Change the ‘Instance State’ to ‘Stop Instance’

Launch Templates

Spot Requests

Instance: i-091a13b1a6e54136c (Grafana)

Details Security Networking Storage Status checks Monitoring Tags

¥ Instance summary Info

» Elastic Block Store
Private IPv4 addresses

Instance ID Public IPva
Volumes i-091313b1abe54136¢ (Grafana) 3.8 n address [ 10.0.0.194
Snapshots
1Pv6 address Instanca state Public IPud DNS
Lifecycle Manager - @ Running £¢2-3-80-10-41 compute-1.amazonaws.com |open address [
¥ Network & Security Hostname type

Security Groups 1P name: ip-10-0-0-194.ec2 internal

Answer private resource DNS name

d IP address
41 [Public IP]

Olec7414cest79547 [2 izer for recommendations. | Learn more (2

Figure 57. Change the EC2 Instance State

Note: For further details on Renesas AWS dashboard types, dashboard quarantine, activation, and
dashboard customization, refer to “AWS Dashboard for CK-RA6M5 and CK-RX65N Application Note”

(R11ANOBO9EU0101).
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8. Sensor Stabilization Time

Table 2 gives the time required for the sensors to sense and provide the valid data to the users. Here you will
see 2 columns, 1) when powered up for the first time 2) after soft or hard reset. If the system boots up from
cold start, the time for the sensors to provide the valid data is up to (1 min — 4 hours), whereas if the system
boots up from warm start, the time for the sensors to provide the valid data is up to (10 sec — 2 hours). For
more details, refer to the specific sensor data sheet.

Table 2. Sensor Stabilization Time

Sensor Name When Powered Up First Time After Soft or Hard Reset
ZMOD4410 IAQ Up to 1 min Up to 1 min
ZMOD4510 OAQ | Upto 1.5 hours Up to 1 hours
0B1203 Up to 20 min Up to 20 sec
(After putting figure on sensor, it may take | (After putting figure on sensor, it may
up to 60 seconds to sense data) take up to 60 seconds to sense data)
HS3001 Up to 30 sec Up to 10 sec
ICP Up to 30 sec Up to 10 sec
ICM Up to 30 sec Up to 10 sec

Note: Stabilization time of the sensor provided above is from the point of sensor initialized.

9. Known Issues and Troubleshooting

¢ This section talks about the known FSP and tool related issues. More details can be found at the link:
https://github.com/renesas/fsp/issues.

e Itis recommended to use the dashboard with Microsoft edge browser; it does not work properly with
Google Chrome browser.

e Incasetheerrorrelatedto wifi init(): “/ERR] In Function: wifi init (), ** Wi-Fi
Init Failure **”is seen on the console every time in spite of good Wi-Fi connectivity, it is
recommended to check the SDK version in DA16600 PMOD. It is required to use DA16600 SDK v3.2.7.1
or later for the application to work correctly. To confirm DA16600 SDK version and update it, please refer
guideline in DA16200/DA16600 SDK Update Guide

o When the application is running successfully, if the Wi-Fi connection goes down on the AP/router end, the
application will not reconnect to the AP/Router. Reset of the Board is required in this case.

e Depending on security levels and configuration of Wi-Fi Router/Modem, sometimes the application may
not connect to the network. Please try Simple AP or Hotspot using iOS/Android system.

10. Debugging

Enable the USR LOG LVL (LOG DEBUG) macro in the application project for additional information of the
error, during debugging.
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Website and Support

Visit the following vanity URLSs to learn about key elements of the RA family, download components and
related documentation, and get support.

CK-RA6M5v2 Kit Information renesas.com/ra/ck-rabm5
RA Cloud Solutions renesas.com/cloudsolutions
RA Product Information renesas.com/ra
RA Product Support Forum renesas.com/ra/forum
RA Flexible Software Package renesas.com/FSP
Renesas Support renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an 1/0 pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between Vi
(Max.) and Vin (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between ViL (Max.) and Vi (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1.

10.

11.

12.

13.
14.

(Note1)

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use
of these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product
that is inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.
Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.
Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.
It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.
This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

“Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.

(Note2)

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

“Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)
Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.

© 2023 Renesas Electronics Corporation. All rights reserved.
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